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Art Bendick
opened the
meeting and
welcomed
members. There
was a new guest
today that
joined the club,
Brad Popejoy.

things in auto
start up.

Question and
answers:
Discussed how
to disable
Microsoft One
Drive.
Discussed
power options –
never set
computer to
sleep.
Discussed
Internet
computer
camera
settings.
Discussed
turning off

Old business:
Neal gave
report on Fry’s
trip and lunch
at Portello’s.

IN TE RGRAT E

Treasurer’s
report for June
and July was
presented by
Joe and
accepted.

New business:
August board
meeting is on
Wednesday,
8/14/19, at
Angelo’s in
Sterling.

Program was
given by Terry
with an
informational
session on “Will
this charger
work?” and a U
Tube video on
“Tips for
charging your
phone”. Also
presenting was
Neal with a You
Tube video by
Palo on Android
Tablets “Back
to Basics”.
Next month’s
program will be
presented by
John Miller on
iPads and
iPhones.

Adjournment:
Meeting was
adjourned.
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BOARD MEETING MINUTES
FOR
AUG 14 , 2019
Meeting was called to
order.
Attending the meeting
were President Art
Bendick, Treasurer Joe
Fornero, V.P. Neal
Shipley, board members
Tom and Nancy Rich.
Ken Hughes was also in
attendance.
Treasurer’s report was
presented by Joe 1.

September Drawing

December-Santa
Joe-potluck
December
with Chicken George, onion
rings and sweet potato fries.
Members bring a dish to
pass (desserts and salads).
Adjournment:
Motion made by Joe F. and
seconded by Tom.
Respectfully submitted by
Nancy Rich, Secretary

For September a $50 gift
certificate from either Galena
Steak House or Candlelight as
large prizes. You can only win a
large prize once per year.
Smaller prizes will include a 2$25 gift cards from Walmart,
Pizza Ranch or Menards, along
with a 256 Gb 3.0 flash drive
and other misc. items and you
can win them as often as your
ticket is drawn, but only one
per month.

Discussion Highlights:
Future Programs:
SeptemberSeptember John Miller –
topic is iPhone and iPad.
OctoberOctober Neal with video
presentation of some
kind and packing
Operation Christmas
Child shoe boxes.
NovemberNovember Tom Rich Basic cleaning of
computers to optimize
performance.

H E LPI NG

OTH E RS

IN TE RGRAT E

T E CHNOL OGY

IN

TH EI R

DA ILY

LIV ES

Page 3

Using a Web Browser
By Jim Cerney

Have you heard of
Google Chrome,
Microsoft Edge, Firefox,
or Safari? Well, they
are all Internet
Browsers – apps
(programs or software)
that allow you to see
web pages and cruise
the internet. No
computer should be
without one! Windows
computers come with
Microsoft Edge
included for free, but
the others are free as
well.
Do not confuse a web
browser with a search
engine. A search
engine, such as
Google, is a web page
that you use to search
the internet for
something – and you
can get to Google on
any browser. All web
browsers will do the
same things, maybe in
slightly different ways,
and it is up to you to
pick the ones you like
to use. Here are some
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tips and information for
using any browser:

address you will “go to”
and see that web page.

1. You need internet
access to use a
browser. If you do not
have internet access
and try to use it you will
get a message that you
are not connected.

3. The “search/address
bar” displays the web
page address of the
page you are looking at.
You can highlight and
copy this address to
paste it in a document,
email, etc.

2. Use the “search/
address bar” to enter
either text you want to
search the internet for
OR a web page address
(like www.thestug.org).
The browser will
determine if you are
doing a search (not
entering a valid web
address) and will use
the default search
engine to do the search
and display your
results. Firefox, for
example, will use
Google by default as its
search engine. Most
browsers will allow you
to change the default to
another search engine
in “settings.” If you
enter a valid web page
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4. As you browse the
internet and click on
different things, new
web pages will be
displayed – and you are
creating a “chain” of
web pages. Not every
“click” will create a new
web page in the chain,
some may create a new
“tab,” for example. Use
the “left and right
arrows” to go to
previous web pages
(left) or to web pages
you have already
viewed (right).
5. The little “house” or
“home” icon will take
you back to your
TH EI R
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Using a Web Browser (cont.)
starting web page.
6. The menu of
options, including
“settings,” “help,”
and more is
displayed by clicking
on the three lines
(called a
“hamburger”) or
three dots in a
vertical line.
7. TABS – those
things on the top row
of your browser (or
near the top), are
used to create a new
“window.” You may
think of a tab as if
you opened another
session of your
browser. As you click
on different links
sometimes a new
tab will be created
for you. Tabs can be
helpful if you learn
how to use them.
Create a new tab by
clicking on the plus
sign “+” at the right
end of the tab row. It
is easy to return to a
H E LPI NG

OTH E RS

web page by clicking on
the tab. In your browser
settings it is possible to
have a set of tabs
opened and ready for you
when you open the
browser.
8. SETTINGS – Can
provide the many
options, help, and
defaults for your browser.
Most browsers will have
a video of how to use it
and will describe what
each setting option does.
9. By all means go to
Google and ask, “How do
I use Google Chrome” (or
any browser you prefer)
to see videos and help.
Take a few minutes to
learn more about your
browser!
10. FAVORITES or
BOOKMARKS will let you
create a list of all your
favorite web pages. You
can organize this list any
way you like, including
creating “folders.”
IN TE RGRAT E
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Clicking on a bookmark
may or may not create
a new “tab.”
11. History, cookies,
and other records are
created by all browsers.
Look in settings and
ask Google about the
options for your
browser to turn off
these things or to
delete them. Usually it
is a good thing to
delete your history
upon exiting your
browser session.
Learning is good for
you. And learning how
to use your browser
opens up more ways to
learn using the
internet. Enjoy your
potential.
By Jim Cerney, Forum Leader, The
Sarasota Technology Users
Group, FL
June 2019 issue, The STUG
Monitor
www.thestug.org
jimcerny123 (at) gmail.com
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Research Before Online Shopping
By Richard Durand
As the old saying goes, “When
the going gets tough, the tough
go shopping.” Here in the 21st
Century, we don’t have to be as
tough to be shopping because
now a lot of shopping can be
done online. In terms of placing
orders, methods of payment,
shipping, etc., I really don’t have
anything to contribute. But the
browsing and research
necessary to make a selection
has been radically transformed
and enhanced in a lot of
unexpected ways.
Here are a few. One of the nice
things about going to an oldtime store was to be able to
pick up and inspect an item.
That was a plus for in-person
shopping, though maybe not
enough if the item was sealed
and/or shrink wrapped.
Something I discovered that I
found to be much, much more
useful and better was to do a
search on a potential selection
in the YouTube search box, and
add this word, “unboxing.”
Then, click on one of the search
results and watch a video on
the selection. Oftentimes, the
video will be done by a store
salesman with not only product
knowledge but practiced
communication skills that he
will use to describe things
understandably. He’ll hold up
the contents one by one and
identify them for you. It just
might help.
Another useful online research
technique is to look at the
reviews for an item on Amazon.
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From what I’ve seen, Amazon
allows just about anyone, not
just the pros, but actual users
and customers, to compose and
upload a review of just about
any item posted. The reviewer
has to give a rating from one to
five stars and then has space for
further explanations. Many leave
only very terse comments, if any,
but there are a surprising
number who offer long stories
and multiple reasons for their
ratings. These authors seem to
have acquired a purpose in life
of informing the rest of the world
about their experiences with a
product or a company’s
customer service. Personally,
I’ve got better things to do, but
I’ll gladly take advantage of the
reviews of others.
And the one final method of
research, which is blatantly
obvious, but still worth
mentioning, is to just enter a
product name or even just a
general category, such as
“scanner” or “RAM,” into the box
of a browser search engine,
such as good old Google, and
add this word, “reviews.” There
might be lots and lots of search
results, some of which might
prove to be very useful. One I
like to see is something along
the lines of “What to look for in
a ? (whatever).” Or there might
be a result along the lines of
“Top ten headsets, or widgets,
or whatever.” Even if there is no
worthwhile product to select,
such searches might reveal
some very important
information, such as what
critical attributes to look for,
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what price range to expect,
and what local establishments
have this type of product
available.
For me, positive or negative
reports are less important
than the information provided.
Something that’s praised to
the skies might not be what
I’m looking for, and something
else that’s condemned in a
review might be just what I
need. Numerical ratings are
just opinions, at best, starting
points, and are secondary.
The internet empowers one to
make up one’s own mind
about shopping and about a
lot of other things, so one
might as well use one’s own
mind. And if enough of us do
our online shopping with these
methods, I am convinced that
the vendors will be motivated
to improve in price, quality,
and customer service. For
them, it’s getting more and
more competitive. And for us,
all of this can be done from
one’s own computer, tablet or
smartphone.
Happy shopping!
Richard Durand, President,
Wisconsin All-computer Users
Club, WI
June 2019 issue, WAUCtalk
https://www.wauc.us
rgdurand (at) yahoo.com
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Two Ways to Add Style to a Word Document
By Nancy Demarte
Microsoft Word is loaded with
features that give style to
documents. “Style” in this case
means modifying the look of
text and paragraphs. To do
this, many users change the
font or font size, add effects
like bold or color and maybe
change the space between
lines. These changes are made
one at a time and can be timeconsuming. Plus, you’ll have to
do it again the next time you
want that style.
There are tools, however, that
add style in easier and more
coordinated ways. The first one
is on the Home tab > Styles
group. This gallery contains
what could be called “Style
Parts” because they add style
to parts of documents like
titles and headings. The other
style-adding feature is the
Document Formatting group on
the Design tab. This gallery lets
you apply a group of stylistic
features to a document all at
once. These are called “Style
Sets.” Here are a few tips for
using Style parts and Style
sets.
Style Parts:
The Styles
group on the
Home tab
offers several
styles which
can be applied to parts of
documents or used to create a
special kind of document, like
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a company or club logo. To
see the entire Styles
gallery, click the More icon
at the right end of the
Styles group. Let’s say you
have a document with
headings above each
paragraph, as this article
has. You would like to give
them a different appearance
from the rest of the text. To
preview how some options
would look, select your first
heading and move your
mouse pointer over the styles
in the gallery to see how they
change the heading. When
you find one you like, click it
to apply the style to the first
heading.
But what about all the other
headings in your document?
This is where Format Painter
can help. Select the heading
to which you just applied a
style. Then double click
Format Painter on the Home
tab > Clipboard group to
keep Format Painter
enabled. Drag your mouse
across each of the remaining
headings to apply the same
style as the first one. When
done, click Format Painter
once to turn it off and save
the document. I created and
applied a style to the
headings in this article as an
example. It has a different
font, font size, and color from
the rest of the text.
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Modify or Create a New Style:

Sometimes, you won’t find
the style part you want in the
gallery. This is when you can
change a gallery style or
make your own. To create a
new style and add it to the
gallery for future use, open a
document and select a
heading. Using the tools in
the Home tab > Font group,
make your changes. With the
newly styled text selected,
click the More icon and then
click ‘Create a Style’ to open
the ‘Create New Style from
Formatting’ box.
Give the new style a name
that relates to its features
and click OK. Your new style
will appear in the Styles
gallery. I named my heading,
“Blue Antique Heading,”
based on the font I used. If
you don’t find your new
heading style in the gallery,
click the More icon again,
click Apply Styles and then
click the new heading style
name. Now should see it in
the gallery.
Style Sets:
You can apply a group of
style features to a whole
TH EI R
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Two Ways to Add Style to a Word Document (cont.)
Change
Styles, then
point to
Style Set.
Preview it
the same
way as
described
above. Then
click a style
set to apply
it to your
selected
document.
Set a
document at once using Style
Sets. This includes features
on the Home tab in the Font
and Paragraph groups. In
Word version 2013 and later,
Style sets are found on the
Design tab. Open this tab
and click the More icon at the
right end of the Document
Formatting group to see the
built-in style sets. Preview
how these would look on your
document by clicking
anywhere in the document
and moving your mouse
pointer slowly over the
gallery. Click a set to apply it
to your document. If you
change your mind, remove
the style by clicking the Undo
icon (a left-curving arrow at
the top left above the ribbon)
or pressing Crtl+Z on the
keyboard.
For those with Word 2007 or
2010, the steps differ a bit.
Click the Home tab, and in
the Styles group, click
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Style Set as Default:

The default style set in Word
is called Normal. This means
whenever you type in a blank
document, all the features of
the Normal style set will be
used. If you wish to modify
the Normal style, make your
changes, but give it a new
name, which will leave the
Normal style set intact. We
do this so it doesn’t cause a
problem when you open older
documents. Microsoft has
changed its Normal style
properties over the years.
(For example, Arial was at
one time the default font;
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now it’s Calibri.)
You can choose any Style set
to become the default. First,
apply all the features you
want. Then preview how it
would look and add it to the
Document Formatting gallery.
Finally, click its gallery
thumbnail, and click “Set as
Default” which appears at
the right end of the
Document Formatting group.
Now all new documents will
be formatted according to
your default Style set. You
can change the default style
at any time.
The way to master Styles is to
start small, such as applying
headings or titles using the
Styles gallery on the Home
tab. After Microsoft changed
the default line spacing from
1.0 (single space) to 1.15, I
created a style that was
single-spaced. That was the
only change I made to the
Normal style, but it comes in
handy when I want to save
space.
By Nancy DeMarte, 1st Vice
President, Sarasota Technology
Users Group, FL
June 2019 issue, STUG Monitor
www.thestug.org
ndemarte (at) verizon.net
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The next meeting of the Sauk
Computer User Group will be
There will be a Question &
Answer Session starting at 1 PM.
Bring any questions you have
about your computer or
problems you may be having.
It will be conducted by:
Art Bendick & Neal Shipley

September 14, 2019
Question & Answer : 1 PM
Business Meeting : 1:30 PM
Presentation: 2:00 PM
Place: Whiteside Senior Center
1207 West 9th Street
Sterling, Illinois 61081

September Presentation will be:
iPhones and iPads by John Miller

